WAacGo

Information on Handling Print Material

Information on Print Material
Note: Individual information on handling print material are representative of other print materials with
identical handling. The graphics in these notes only represent the print material to be named.
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1. Hardware Preparation

1.1 Roller

1.2 Sensor Settings
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2. GoDoctor — Measure the Print Material Dimensions
GoDoctor printer software
Always use the most up-to-date version of the software. Check your existing installation to make sure that it is

up to date, or download the newest version.

The program file GoDoctor.exe can be found in the smartSCRIPT installation directory on your PC / laptop.
C:/Programme(86)/Wago/smartScript/...
Notice: The [Factory Default] button resets the printer to factory settings.

s GoDoctor Utility For GoDEX Printer V1.001 LI SIS
[Port Help
‘ Printer Configuration l e Auto-Calibration l
|
[
TPH Mileage Reflective Sensing Test

TPH Dot Test Transmissive Sensing Test

Cutter Test

Dump Mode (OFF) Factory Default

|
Printer Status ‘
|
|

Clear |

o Reset Printer

Command Mode

|
|
|
|
|

" Connected use WAGO smartPrinter=14370792 BOOT:1.003 F/W: smartPrinter V1.UW7e

Figure 2.1: GoDoctor dialog box
All individual bits of information (this includes network settings) will be deleted!

Press [Reset Printer] o Wait until the bar of the progress indicator in the display has gone through. The
current print media settings are deleted. The end of the process is confirmed after 20 seconds, by a simple
acoustic signal.

Press [Auto-Calibration] e Material will be fed through the printer!

Figure 2.2 shows the info area in the GoDoctor dialog box with the correct information in line 1 and 4 on the
print material after auto-calibration.

Important:

Auto-calibration has failed if the information in the info area deviates from the information shown in
Figure 2.2.

Check the sensors setting and run auto-calibration again.

Contact our support team if doing this does not yield the results shown in the image.

Label With Gaps

See-Through Sensing Mode

Figure 2.2: The information area shows
results for the print material
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3. WAGO-Printer-Settings - Set Printer Settings

WAGO-Printer-Settings
Always use the most up-to-date version of the software. Check your existing installation to make sure that it is

up to date, or download the newest version.

Start the WAGO-printer-settings.

WAEU Printer-Settings LE L)

- L - -
Change Offsets/Heat Reset Settings Own Labels Options ﬁ
Installed printers: Selected printer: 2., Export a er seltings
e ter 1) Reset smarPrinter
T ~ G FastViewer
rver verson: S
(29 Check for update
Port: Show only Favourites
*. Marking Strip
*. WM Infine
= Labels
(75 210-805 3 210-805/000-002
W Label 15:6 mm (white) B | Libed 156 mm yellow) W
5 210-806 3 210-806/000-002
S el 159 mm (white) B | 5P Lba150mm (yellow) e
5 210-807 73 210-807/000-002
S Lol 206 mm (white) B 5P Lba20amm (yellow) e
% 210-808 5 210-810
P L9525 mm B 5P b sasmm e
*. Typesigns
= MCS labels
= Button labels

= Wire/cable marking
* Heat Shrink Tube

= Fabric labels

Figure 3.1: WAGO-printer-settings

In the [Installed Printer] o window, choose the WAGO smartPRINTER.
Open the [Options] menu Q and deactivate [Autosensing].

Select the directory e

Select the print material @.

The specific printer settings for the article are transferred to the smartPRINTER as soon as you select the print
material.
Press [OK] to confirm the following instructions dialog box (Figure 3.2).

Information

i Import successful

OK

Figure 3.2: Instructions dialog box for driver

The smartPRINTER is now properly set up for the print material.
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4. WAGO-smartSCRIPT - Creating Project Files

WAGO-smartSCRIPT
Always use the most up-to-date version of the software. Check your existing installation to make sure that it is

up to date, or download the newest version.

Important: Uninstall the existing WAGO-smartSCRIPT-software before carrying out any new installations.

Start the WAGO-smartSCRIPT to make the following selections using the wizard:
o Press [Forward] to confirm that [You know the item order number of marking material].

If the wizard does not start up, select [New document (WAGO SCRIPT Wizard)] from the [File] menu bar.

Select the print material 9 and the wizard by clicking on [Finish]e.

4 WAGO SMART SCRIPT wizard —— 24 WAGO SMART SCRIPT wizard (=X
|
_— ‘ Select marking material
“  How do you want to start? | [ 22-210708 forky TP238/TP343)
A [ =] | | 23-210710 (orly TP238/TP343)
24210732 (ory TP238/TP343)
YYou know the series of the terminal block 25210801 e
%- 210802 =
27210803
28. 210804
© You know the item order number of marking material 29-210-805
30- 210-805/000-002
e 31210806
SERNER 32-210806/000-002
S ‘You know the marking device 33 210-807
34- 210807/000-002
3210808 SR AN
36- 210610 SR
projectfile create from import data. 37. 210811 AN g
38- 210811/000002 Y
Descipiion: order numbe
sell-adhesive polyester label white 156 3000 pes/roll - 210-805
Width Marking device:
7] view wizard after each start Theail)ransfor e
Cancel B Forward >> Fir Cancel <« Back Forwar Finish Q
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Individual Labeling
Input options for labeling text:

a) Select the marking field by double-clicking and then enter the label/caption text.
Click in the dark gray area of the window to accept the text.

b) Click [Edit Text] 0 and then click in the marking field to input text. Click in the dark gray area of the
window to accept the text.

c) Click once to select the marking field. Under the [Properties] tab, 9 enter the labeling text in the input
area [Text]. Press the enter button to accept the text.

[%f WAGO SMART SCRIPT - [Unnamed] =ne
¥ File Project Edit View Edras Window Help
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b o | = v T | O BB
Y Project | € Liary
4 2} C:\Users\Public\Documents\WAGO Text
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{2 E. Symbol
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Horizontal:
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ine spacing: -

content: -

Figure 4.1: WAGO smartSCRIPT dialog box

Duplicate the written labels

Click once to select the marking field. Click the [Duplicate Block] Oor click on a marking field and click the
right mouse key to open the context menu.

Select [Duplicate Block] from the context menu.

=4 WAGO SMART SCRIPT - [Unnamed] = 8 X
¥ File Project Edt Vi

N O50hiMem Mo B»00x9C EEEEE?

A | matfont ~ Reguar -8 v A & W A

P

s R “?x g B | O B
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4 {2} C:\Users\Public\Documents\WAGO| Text
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« i y L
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Ine spacng: [standard v

content: | modifisble v

Figure 4.2: WAGO smartSCRIPT dialog box—Duplicate block/the selected marking field is blue

Enter the number of duplications in [Duplicate Blocks] and carry this out by clicking on [Accept].

Duplicate blocks = 1 2
Accept
—_ —) 1 ,
Block insertion mode: [Append to end ']
1 2
Figure 4.3: Duplicate Blocks dialog box 1 2

Figure 4.4: Duplications result - 3 additional
lines with identical text
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Automatic Numbering
Automatic input option for alphanumeric labeling
Click [Paginate] o on the toolbar.

Ef[WAGOSMARTSCRlPT-[Unnamed] - o8] X
i¥ File Project Edit View BExdras Window Help

Dok Me=Nog )l »0DX?CIEEAEEEHD
: 1 e

® | |4 &R A

B R = 8 R T B

The [From:] [To:] numbering range is entered under the [Definition] tab in the [Automatic Numbering] dialog
box. As shown in Figure 4.5 [From:] 1 [To:] 6.

Additional options for configuring text are available under this tab.

Place a checkmark on the [Options] tab in the [Automatic Numbering] dialog box [If necessary, append new
page] (Figure 4.6) The number of label fields required for your input is automatically added.

Automatic numbering = Automatic numbering [
Definition | Options | Definition | Options _
Settings for numbering Preview
Frome |1 1 | Append new page if necessary [W]
To: & g
Numbering mode: [Il-c-nal—v] ;
Steplength: 1 o  Stendad T
Prefix:
Suffix:
Repeat entry: 1
Repeat numbering: 1
Interval text:
Intervat 1 R
Ve i
Figure 4.5: "Automatic Numbering" dialog box Figure 4.6: "Automatic Numbering" dialog box
"Definition" tab "Options" tab
TIP

Click [Adapt to Window] Q on the toolbar in order to display all marking fields at their maximum size in the
viewing window.

@ WAGO SMART SCRIPT - [Unnamed] =B P9

{# File Project Edit View Extras Window Help
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Importing Markings
WAGO smartSCRIPT supports importing *.xls, *.xlsx, *.txt, *.csv and *.dat files.
Click [Import...] on the toolbar.

ijGOSMARTSCNPT [Unnamed] - = @ %)
L Project Vie W
@ mw-[]«/‘ B ~0DX9CEEEEER S
* & &
D'D\:m@ 90 g

Click on [...] in the [Data Import] dialog box Figure 4.7. Select the file you want to import from the file
directory and open it with the [Open] button. The file is opened in the display area of the dialog box.
Options for selecting cells:

&= Data import

e e e ™ —_— Cells that follow each other one after another from
S ;KJ column 1lor2

= S Same cell area for columns 1 and 2

e e Sequential cells in columns 1 and 2

- i

e an — Select cells by clicking on them or dragging the mouse.

Click [Accept] to transfer the contents of the cells to the
Figure 4.7: "Data Import" — Highlighted cells 6, 7, 8 labels.
and 9 in column 2 Close the [Data Import] dialog box.

The contents of the selected cells from the import file have been transferred to the marking fields
Figure 4.8).
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 Fle Project Edt View Etras Window Help — = =
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Figure 4.8: The contents of selected cells 6, 7, 8 and 9 from column 2 are transferred to 4 labels.
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5. Print
Start the print job using WAGO smartSCRIPT.
Click [Print] on the toolbar.

£4/ WAGO SMART SCRIPT - [Unnamed]

[@ Fite Project Edit View Extras Window Help
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+* & &
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Use the [Print] dialog box to indicate the number of copies to be printed.

Accept the other settings displayed in the [Print] dialog box.
Start the print job by clicking on [OK].

Print 5 ? &

Printer

Name: WAGD smartPrinter v

Status Bereit

Type WAGO smartPrinter

Location USEOO

Comment [7] Send ta file

Print range Copies

OFA Number of copies: 1 $
Pages From|1 Toll

Marker

[T Print border (horizontal) [T] Only selected range

[T Print frames (vertical) [ Emulate TrueType

[¥] Print contents

Output settings

Line thickness: 0,20 mm Displacement: 0,00 mm
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6. Correcting Print Quality, Tracking Position and Cutting Option

WAGO Printer Settings software allows you to correct the printing quality of the labeling text afterwards.
If the cutter is used to cut the print material, activate the [Cutter active] option in the selection window.
Note:

The [Cutter active] and [Overrun (mm)] options are only available to you for print materials that are
approved for cutting with the cutter.

The procedure described in this chapter is representative of all print materials.

Description of defects:
a) The labeling text is not printed vertically centered.
The labeling text is moved up or down (Fig.1).
b) The labeling text is not printed centered horizontally.
The labeling text is moved to the right or left (Fig 2).
c) The labeling text is faint or has not been completely printed (Fig 3).

1 2
1 2
3 4 3 {
3 4
Fig. 1: Moved vertically Fig. 2: Moved horizontally Fig. 3: Print-out faint and

incomplete

Start the WAGO Printer Settings:

Select directory o
Select print material Q
Select gear icon 9 for print material.

Correction option by changing values:

a) [Vertical(mm)] Increase value Labeling text will be moved upward.

[Vertical(mm)] Decrease value Labeling text will be moved downward.

b) [Horizontal(mm)] Increase value Labeling text will be moved to the left.

[Horizontal(mm)] Decreased value Labeling text will be moved to the right.

c) [Heat] Increase value =  Labeling text will become darker.
Notice! A value >14 might damage the color ribbon.
[Heat] Decreased value =  Labeling text gets lighter.

d) [Cutter active] =  Not selected (Fig. 4)

The value entered in [Overrun (mm)] defines the feed path of
the print material after marking.

e) [Cutter active] =  Selected (Fig. 5)
The value entered in [Overrun (mm)] defines the feed path of
the print material to the knife position of the cutter.
Notice: Increase or decrease the overrun value stepwise in
one tenth (1/10) increments. The overrun value may not
exceed 38 mm!
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- PR -
Change Offsets/Heat Reset Settings Own Labels Options - e 4 & =m
Change Offsets/Heat Reset Settings Own Labels Options
Installed printers Selected printer
D Installed printess: Selected printer
V' WAGO smartPrinter
h
eat 12 heat 12
herizontal (s i
orizontal (mm) 75 horizantal (mm) 75
vertical (mm
(mm) 0 wvertical (mm) 0
Trail (mm)
il (¢ ER) Trail (mm) 5
%, Marking Strip Cutter, active
TR %, Marking Strip Cutter, active v
Close Save %, WMB Inline
B Labels Close Save
s Labels
Label
Label
Type signs
Type signs
5 210-801 . 5 210-802 -
A% Label 33x70 mm (white) e ¥ Label 3370 mm (silver) 5 210-801 3 210-802
<A Label 33370 mm (white) W "% Label 33470 mm (sitver) w
3 210- o 3 210-804 m
*% Label 44:99 mm (white) L * Label 44x99 mm (silver) e 5 20 o 3 210-804 o
Label 44:99 mm (white) £ Label 44x99 mm (silver) W
5 210-812
** Label 2550 mm silver w 3 210812 .
< Label 2550 mm silver s

Changing the values [Save] then [Close].

Now perform several test printouts.
The printer needs the test printouts to adjust and implement the correction values.

Note:
You can also use the auto calibration button on your smartPRINTER to start the calibration of the print

material.
Further information on this topic can be found in the smartPRINTER operating manual.
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